
 

 

Thank you for purchasing this exciting new product from Quartet! The Quick Set Up 
Guide explains how to install your new system quickly and easily. This Users Manual 
will show you how to save time and money by capturing notes and diagrams, collabo-
rating with colleagues, and enhancing presentations. Please see the Software Refer-
ence Guide for quick explanations of how to use the various features made possible 
by eBeam Software. 

 

 

 

 



FCC Class B Notice 

This device complies with Part 15 of the FCC Rules. Operation is subject to the follow-
ing two conditions: 

1. This device may not cause harmful interference. 

2. This device must accept any interference received, including interference that may 
cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. 
This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 

* Reorient or relocate the receiving antenna. 

* Increase the separation between the equipment and receiver. 

* Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

* Consult the dealer or an experienced radio/television technician for help. 

Foil Shielded Cables: 

Connections between the IdeaShareTM board and computer and other devices must 
be made using foil shielded cables in order to maintain compliance with FCC radio fre-
quency emission limits. 

Modifications: 

Any modifications made to this device that are not approved by General Binding Cor-
poration may void the authority granted to the user by the FCC to operate this equip-
ment. 

Canada Class B Notice - Avis Canada, Classe B 

This Class B digital apparatus complies with Canadian ICES-3. 

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada. 
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Chapter 1 

Quartet® Portable IdeaShare® 

The Quartet Portable IdeaShare system uses eBeam® electronic imaging technology to 
capture notes and images from any standard whiteboard, easel, or even flipchart pads. 
Using the Quartet Portable IdeaShare, whatever you draw on a whiteboard or easel is 
captured electronically in color and in real time and can be saved to a PC, Mac, the 
Internet or local Intranet.  Using the software, you can also share sessions with 
remote participants live over the Internet/Intranet and create interactive 
presentations with the virtual touchscreen capability. 

 

 

Software Features 

Additional popular software features: 

•  Share whiteboard drawings in real time over the Intranet/Internet in an eBeam 
meeting. Microsoft NetMeeting can also be used to share meetings. 

•  Replay, edit, and annotate images from your meetings and attach them to email 
messages. 
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•  Import images, files, or even a snapshot of your own computer screen into the 
background of the current meeting for all users to see and annotate. 

•  Use eBeam Software with a projector to turn your whiteboard into a virtual touch-
screen. 

•  A "wake up" or Autolaunch feature automatically wakes up the eBeam Software 
and begins to record once an electronic pen touches the whiteboard. 

•  eBeam Software automatically checks for software updates to make sure you 
always have the latest features. 

The Software Reference Guide is included for quick, easy-to-understand instructions 
on how to use the main software features.  This guide is very handy when your 
Quartet Portable IdeaShare is shared by many users.  Simply leave the guide next to 
the product so everyone can be comfortable with the software and begin taking 
advantage of this collaboration tool!  For more detailed instructions on how to use all 
of the many software features, refer to the Help menu in the software. 
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Chapter 2 

Using Quartet Portable IdeaShare 

The Quartet Portable IdeaShare system is shown in the image below... 

 

Figure A 

Installing Quartet Portable IdeaShare 

There are various ways to install your Quartet Portable IdeaShare system.  See the 
Quick Set Up Guide for the standard whiteboard installation (with a suction cup 
mounting bracket).  If you intend to only use your Quartet Portable IdeaShare on 
one whiteboard, you may choose to permanently attach the mounting bracket using 
the supplied adhesive strips (the mounting bracket has two flat ledges to 
accommodate the adhesive strips).  For a more permanent attachment, the 
mounting bracket has three holes for #6 and #8 screws (not included).   Even if you 
permanently install the mounting bracket, you will still be able to remove the Quartet 
Portable IdeaShare receiver.  For flipchart use, please see “Using Quartet Portable 
IdeaShare with a Flipchart” on page 7 for instructions on how to mount the Quartet 
Portable IdeaShare onto a flipchart with the flipchart clip.   



Page 4 Using Quartet Portable IdeaShare 

 

The following sections describe the three different ways to use the Quartet Portable 
IdeaShare system: 

•  As a digital whiteboard (page 4). 

•  As a virtual touchscreen (page 5). 

•  With a flipchart (PC Only) (page 7). 

Using Quartet Portable IdeaShare as a Digital Whiteboard 

Refer to “Terminology” on page 11 for the definition of various terms used in this sec-
tion. 

In whiteboard mode, the Quartet Portable IdeaShare receiver is connected to a com-
puter using eBeam Software.  Notes and images that you draw on a whiteboard are 
captured electronically in real time and available for storage and display both locally 
and remotely through your local Intranet or the Internet. 

See “Error! Reference source not found.” on page 11 for more information about 
using the software. 

To use the Quartet Portable IdeaShare as a digital whiteboard: 

1. Set up the electronic pens, the electronic eraser, and the software as shown on 
the Quick Set Up Guide, and make sure that the receiver is connected to your 
computer using the USB cable. 

2. Set up the Shortcut Strip on the whiteboard by peeling away the backing and 
placing the strip along an edge of the Image Area. The Shortcut Strip is best 
positioned along the bottom or side edge to avoid taking up writing space on the 
whiteboard. 

3. Launch eBeam Software on your computer, and make sure that you are in 
whiteboard mode. You must calibrate the Quartet Portable IdeaShare to the 
whiteboard, and also calibrate the Shortcut Strip.  See “Software Installation & 
First Time Use” on page 12. To make sure you are in whiteboard mode: 

•  PC: Open the eBeam task bar menu and select “Capture from Whiteboard” 

•  Macintosh OS 9.X: Open the eBeam control panel from the control strip menu 
and select “Whiteboard mode”. 

•  Macintosh OS 10: Open the eBeam System Settings dialog from the eBeam 
docklet icon.  Select “Whiteboard mode”. 

4. Begin writing on the whiteboard using the electronic pens and electronic eraser. 
Notes and images drawn using the electronic pens and eraser are stored in your 
computer. See “Error! Reference source not found.” on page 11 for more 
information about using the software. 
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Using Quartet Portable IdeaShare as a Virtual Touchscreen 

Refer to “Terminology” on page 11 for the definition of various terms used in this sec-
tion. 

In virtual touchscreen mode, Quartet Portable IdeaShare allows you to use your 
whiteboard as your computer desktop.  Both the Quartet Portable IdeaShare receiver 
and the projector connect to your computer.  The projector displays your computer 
desktop onto the whiteboard and the Quartet Portable IdeaShare receiver detects 
when you touch the board, allowing an electronic pen (using the plastic stylus insert) 
to act as a virtual mouse used to control your computer’s desktop. 

In virtual touchscreen mode, you can operate your computer directly from the white-
board.  You can open, work in, and close applications, draw freehand in painting and 
drawing applications, or you can operate the eBeam meeting application directly from 
the whiteboard. 

Virtual touchscreen mode setup is illustrated below. 

 

Figure B 

To use the Quartet Portable IdeaShare in virtual touchscreen mode: 

1. Set up a single electronic pen with the plastic stylus insert. The plastic stylus 
insert looks just like a dry-erase marker except it is entirely plastic and contains 
no ink. 
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2. Connect the USB cable to the Quartet Portable IdeaShare receiver and your 
computer, and set up the software as shown on the Quick Set Up Guide. 

3. Attach the projector to your computer, and make sure that both the projector and 
your computer are turned on. 

4. Aim and focus the projector as near the center of the whiteboard as possible. 

5. Launch eBeam Software on your computer, and make sure that you are in 
projection mode.  You will also need to calibrate.  See “Projection/Virtual 
Touchscreen Mode” on page 18. To make sure that you are in projection mode: 

•  PC: Open the eBeam task bar menu and select “Use With Projector” 

•  Macintosh OS 9.X: Open the eBeam control panel from the control strip menu 
and select “Projection mode”. 

•  Macintosh OS 10: Open the eBeam System Settings dialog from the eBeam 
docklet icon.  Select “Projection mode”. 

6. Begin using the Quartet Portable IdeaShare and whitebaord as a virtual 
touchscreen. Click or double-click applications to open them, move files, draw in 
paint programs, or share a meeting using the eBeam meeting software. Anything 
that you can do with the mouse attached to your computer, you can do with 
Quartet Portable IdeaShare using the electronic pen and stylus. 
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Using Quartet Portable IdeaShare with a Flipchart 

Refer to “Terminology” on page 11 for the definition of various terms used in this sec-
tion. 

Important: To use Quartet Portable IdeaShare with a flipchart chart you must run 
eBeam Software on a PC. The Mac version of eBeam Software is not compatible with 
Flipchart mode. 

Quartet Portable IdeaShare with flipchart clip can be used with two standard flipchart 
sizes (27” x 34” and 25” x 30.5”), or a custom size that the user specifies. The 
flipchart clip (shown below) is included in the box. 

The flipchart clip (Figure C) has a raised portion that is used to mount the Quartet 
Portable IdeaShare receiver, and an embedded Shortcut Strip. 

 

Figure C 

To set up Quartet Portable IdeaShare with a flipchart: 

1. Set up the electronic pens and the software as shown on the Quick Set Up Guide, 
and make sure that the receiver is attached to your computer using the USB 
cable. 

2. The Quartet Portable IdeaShare receiver attaches to the flipchart clip in the same 
way that it would attach to a mounting bracket (Figure D).  Notice that there are 
small hooks on the back of the receiver.  These hooks fit into slots located at the 
top left raised portion of the flipchart clip.  Fit the receiver hooks into the 
flipchart clip slots, and then press the receiver down until you either hear a click 
or feel the receiver snap into place on the flipchart clip. 
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Figure D 

3. Attach the flipchart clip to the cardboard flipchart pad backing.  The flipchart clip 
is designed to attach on the upper right side of the flipchart (your left side when 
facing the flipchart), and as close to the top as possible. See Figure E. 

 

Figure E 
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4. Launch eBeam Software and make sure that you are in flipchart mode. To make 
sure you are in flipchart mode, open the eBeam task bar menu and select 
“Capture from Flipchart”.    

5. You must then select the flipchart size. The first time you select “Capture from 
Flipchart” a calibration warning dialog opens letting you know that you need to 
calibrate. Click the Calibrate button to open the Flipchart Setup dialog. To 
manually open the Flipchart Setup dialog, choose “eBeam Hardware>Flipchart 
Setup...” from the Tools menu. 

6. The Flipchart Setup dialog allows you to select a 27” x 34” flipchart size, a 25” x 
30.5” flipchart size, or to specify a custom flipchart size. Select/Specify the 
flipchart size and click OK. 

7. Begin writing on the flipchart using the electronic pens (the electronic eraser 
cannot erase markings on a flipchart). Notes and images drawn using the 
electronic pens are stored in your computer. See “Error! Reference source not 
found.” on page 11 for more information about using the software. 
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Chapter 3 

Using eBeam Software with Quartet Portable IdeaShare 
eBeam Software is provided with Quartet Portable IdeaShare. 

Terminology 

Commonly used terms are described below: 

•  Active Page: In whiteboard mode, the active page is the page that currently dis-
plays data as it is written on the whiteboard. 

•  Calibration: Calibration is a process that defines the width and height of the 
Image Area, as well as the accurate placement of each captured point within the 
software window. The whiteboard area must always be calibrated to ensure that 
the electronic pen position is properly detected. After calibration, for each point 
that is tapped, the point is placed in the software window relative to the 
calibration points.  The software knows that the point must be within the 
calibrated width and height range, or the point is not valid and is thrown out.  
The software also uses the calibrated width and height to place the point within 
the coordinate system in the software window. 

•  Flipchart Mode: eBeam Software has three modes: whiteboard, projection, and 
flipchart modes. Flipchart mode is whiteboard mode for a flipchart. Flipchart mode 
is used with the flipchart clip that is shipped with your Quartet Portable IdeaShare.  
The fliphart clip and Quartet Portable IdeaShare are set up with your flipchart as 
described in “Using Quartet Portable IdeaShare with a Flipchart” on page 7. Flip-
chart mode identifies (for the software) the location of the Shortcut Strip on the 
flipchart clip, as well as the size of the flipchart itself, making it unnecessary to 
calibrate.  

•  Image Area:  The Image Area of the whiteboard is the area of the whiteboard 
or flipchart where the electronic pen strokes you make are captured by Quartet 
Portable IdeaShare and transferred into the eBeam Software window.  The 
Image Area is determined by the placement of the receiver(s), and the software 
calibration. 

•  Projection Mode or Virtual Touchscreen mode: eBeam Software has three 
modes: whiteboard, projection, and flipchart modes.  Projection mode (also 
known as virtual touchscreen mode) is when Quartet Portable IdeaShare, your 
computer, and a projector are all used together to make your whiteboard a 
touchscreen.  Quartet Portable IdeaShare and the projector plug in to your 
computer.  The projector displays your computer desktop onto the whiteboard 
and Quartet Portable IdeaShare detects when you touch, allowing any electronic 
pen to act as a virtual mouse.  

•  Whiteboard Mode: eBeam Software has three modes: whiteboard (digital white-
board), projection, and flipchart modes. Whiteboard mode is when Quartet Porta-
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ble IdeaShare acts as a whiteboard recorder; recording data as it is written on the 
whiteboard and displaying that data in the eBeam Software application window.  

Software Installation & First Time Use 

This chapter describes how to set up and use eBeam Software. 

1. Set up Quartet Portable IdeaShare as described in the Quick Set Up Guide that is 
included with Quartet Portable IdeaShare. 

2. Insert the software CD into the CD-ROM drive on your computer. The installer 
(Macintosh or PC) will start up automatically. If the installer does not start up 
automatically, browse to your CD-ROM drive and select the setup program. Follow 
all on-screen directions. 

3. Launch eBeam Software. The first time eBeam Software opens, it opens in 
Whiteboard mode (see “Terminology” on page 11). You are prompted to calibrate 
Whiteboard mode immediately.  

If you do not wish to use Whiteboard mode, skip this step. 

If you do wish to use Whiteboard mode, click Calibrate to open the Whiteboard 
calibration wizard and follow all on-screen instructions. See “Calibrate Whiteboard 
Mode” on page 14 for a description of how to manually start calibration for White-
board mode. 

Note:  If eBeam Software was unable to autodetect Quartet Portable IdeaShare, 
see “Error! Reference source not found.” on page 23. 

4. Select the mode you wish to use. The three possible modes (described in 
“Terminology” on page 11) are:  

•  Whiteboard mode 

•  Flipchart mode 

•  Projection mode 

Note: In the PC version of eBeam Software, the first time you launch eBeam 
Software, eBeam Software opens a mode selection dialog. Select  “Capture from 
Whiteboard” (Whiteboard mode), “Capture from Flipchart” (Flipchart mode), or 
“Use with Projector” (Projection mode), and click the Calibrate button. eBeam 
Software opens the appropriate calibration wizard. 
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To select a mode, see the following table. 

Platform Instructions 
PC •  The “Tools->eBeam Hardware” menu in eBeam Software’s 

Whiteboard mode application. See “ Using The Whiteboard 
Mode Application on page 15. 

•  The Status icon right-click menu in eBeam Software’s 
Whiteboard mode application. See “Using The Whiteboard Mode 
Application” on page 15. 

•  eBeam Software’s Windows taskbar menu. 

Macintosh OS 9.X •  The “Tools->eBeam Hardware” menu in eBeam Software’s 
Whiteboard mode application. See “Using The Whiteboard Mode 
Application” on page 15. 

•  eBeam Software’s control strip menu. 

Macintosh OS 10 •  The System menu in menu in eBeam Software’s Whiteboard 
mode application. See “Using The Whiteboard Mode 
Application” on page 15. 

•  The Status icon menu in menu in eBeam Software’s Whiteboard 
mode application. See “Using The Whiteboard Mode 
Application” on page 15. 

•  The eBeam System Settings icon from the docklet File menu. 

 

5. The first time you use any mode you are prompted to calibrate that mode 
immediately. Click the Calibrate button to automatically open the calibration 
wizard. 

Manually starting is described in: 

•  “Calibrate Whiteboard Mode” on page 14 for Whiteboard mode. 

•  “Using Quartet Portable IdeaShare with a Flipchart” on page 7 for Flipchart 
mode. 

•  “Projection/Virtual Touchscreen Mode” on page 18 for Projection mode. 

6. Set up the Shortcut Strip if you are using either Whiteboard mode or Flipchart 
mode. Shortcut Strip setup is described in: 

•  “The Whiteboard Mode Shortcut Strip” on page 20. 

•  “” on page 22. 
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Whiteboard Mode 

Whiteboard mode is the Quartet Portable IdeaShare acting as a whiteboard recorder; 
recording data as it is written on the whiteboard and displaying that data in the 
eBeam Software application window. 

Calibrate Whiteboard Mode 

The first time you use Whiteboard mode you are automatically prompted to calibrate. 
To manually start the calibration wizard, see the following table. 

Platform Instructions 

PC Select “eBeam Hardware>Calibrate eBeam Hardware” from the 
Tools menu. 

Macintosh OS 9.X Select “eBeam Hardware>Calibrate eBeam Hardware” from the 
Tools menu. 

Macintosh OS 10 Select “Calibrate” from the System menu.   
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Using The Whiteboard Mode Application 

The look and feel of the whiteboard mode application varies between the PC and Mac-
intosh platforms.  The functionality remains the same. 

  

Menus  Allows access to all of software functions and features. 

Toolbar  Allows access to the most commonly used features. 

Active Page  Receives data written on the whiteboard.   The active page will 
always be the most recently created page in the meeting. 

Thumbnail 
View 

 Displays thumbnails of all pages in the meeting. 

Participants 
View 

 Displays the login names of all users connected to a meeting, as 
well as allows users to “chat” with each other using the software’s 
instant messaging system. 

Web View  

(PC Only) 

 The Web View allows access to web pages, and allows the meeting 
host to lead a Web Tour.  

Annotation 
Tools 

 Palette of tools that allow the user to annotate/draw on the 
displayed meeting page using the mouse and/or keyboard. 

Play Controls  Allows you to play back the meeting like a movie. The meeting is 
played forward, line by line, at varying speeds. Also, playback can 
be restricted to either the current page, or set to play all pages. 

Menus 

Toolbar 

Web View 

Thumbnail View 

Participants View 

Annotation Tools 

Play Controls 
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Toolbar 

 

 
New  Saves the active page and opens a new active page. 

Duplicate  Copies the selected page and makes the copy the Active Page. In 
the PC version, the new page becomes the Active Page only if the 
Active Page is duplicated. 

Delete  Deletes the selected page. 

Print  Prints the selected page to the printer connected to your computer. 

Full Screen  Maximizes the software application window on the screen. 

Share Meeting  Share a meeting either over the local Intranet or the Internet. 

Join Meeting  Allows you to log on to a meeting broadcasting over the local 
Intranet or Internet. 

Status Icon  The Status icon reports the connection status of eBeam Software to 
the hardware. A whiteboard icon indicates Whiteboard mode, a 
projector icon indicates Projection mode, a flipchart icon indicates 
Flipchart Mode. A grayed out icon indicates that eBeam Software is 
not connected to the hardware. See eBeam Software’s help system 
for a description of the Status Icon. 

 

Annotation Tools 

 
 

Marker  Allows you to write freehand in one of four solid colors on any 
page. 

Highlighter  Allows you to write freehand in one of four transparent colors on 
any page. 

Eraser  Erases both whiteboard data and annotations from within the 
software. 

Zoom  Enlarges the view of the displayed page. 

Text  Allows you to add text annotations to a page. 
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Pointer  

(PC Only) 

 The Pointer tool is enabled during a shared meeting. The Pointer 
tool allows each meeting participant to point anywhere within the 
meeting window. Each participant’s pointer is displayed in a 
different color.  

The pointer direction (right, left, up, down) can be selected from 
the palette that appears when the Pointer tool is selected. You can 
also hide the pointer by clicking the “Hide Pointer” button from 
the palette that appears when the Pointer tool is selected. 

Selector  Allows you to draw a selection rectangle in the displayed page, 
and then copy and paste the selected area into another 
application. 

  

Play Controls  

 
 

Jump to 
Beginning 

 Jumps to the very beginning of the meeting, which is always the 
original blank page. 

Drag Control 
Slider 

 Allows you to step through the meeting forward or reverse by 
clicking on the drag line, or to immediately jump to a specific 
point in the meeting by dragging the drag bar to a location on the 
drag line. 

Play  Replays the meeting from beginning to end, beginning with a 
blank screen. While playing, the Play button changes to a Stop 
button, allowing you to stop the playback. See Play Speed. 

Jump to End  Jumps to the end of the meeting, restoring all whiteboard strokes 
and annotations. 

Loop 

(PC Only) 

 Replays the meeting from beginning to end, beginning with a 
blank screen. Once the end of the meeting is reached, begins to 
replay from the beginning. Runs continuously. While playing, the 
Play button changes to a Stop button, allowing you to stop the 
playback. 

All Pages  If “All Pages” is checked, then clicking “Play” causes the entire 
meeting is played back. If “All Pages” is not checked, then only 
the currently displayed page is played back. 

Play Speed  Speed at which the meeting is played. 0.5x is the slowest speed 
possible, and 8.0x is the fastest speed possible. 
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Projection/Virtual Touchscreen Mode 

In Projection mode, Quartet Portable IdeaShare, your computer and a projector are 
all used together to convert your whiteboard into a virtual touchscreen. 

Quartet Portable IdeaShare and the projector plug in to your computer.  The 
projector displays your computer desktop onto the whiteboard and Quartet Portable 
IdeaShare detects when you touch, allowing an electronic pen (using the plastic stylus 
insert) to act as a virtual mouse, controlling your computer’s desktop. 

In projection mode, you can operate your computer directly from the whiteboard.  
You can open, work in, and close applications; draw freehand in painting and drawing 
applications, or even operate the digital whiteboard mode application directly from 
the whiteboard. 

Projection mode setup is illustrated below. 

 

Projection Mode Setup 

1. Set up Quartet Portable IdeaShare as described in the Quick Set Up Guide. 

2. Set up the projector, and connect the Quartet Portable IdeaShare and the 
projector to the same computer. 
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3. Turn on your projector, and project your computer’s desktop on the whiteboard. 

4. Open any electronic pen and insert the plastic stylus insert. The plastic stylus 
insert is a plastic piece that has the same shape as a dry-erase marker, but has a 
plastic tip that does not leave marks. 

5. Launch the software and switch to projection mode according to the description in 
“Software Installation & First Time Use” on page 12. 

6. If this is the first time Projection Mode has been run on this computer, you will be 
prompted to calibrate.  That calibration is saved.  If the projector is moved at 
any time, you must recalibrate the software to retain accuracy.  

Note: In the PC version of eBeam Software, the first time you launch the 
software, eBeam Software opens a mode selection dialog. Select “Capture from 
Whiteboard” (Whiteboard mode), “Capture from Flipchart” (Flipchart mode), or 
“Use with Projector” (Projection mode), and click the Calibrate button. eBeam 
Software opens the appropriate calibration wizard. 

7. To manually open the calibration wizard for projection mode, use the following 
table. 

 

Platform Instructions 

PC Click the eBeam Software icon from the Windows task bar, and 
then choose “Calibrate Projection Area...” from the menu. 

Macintosh OS 9.X Select “Calibrate Projection Area” from the eBeam Software 
Control Panel, which can be accessed through the eBeam 
Software’s Control Strip menu. 

Macintosh OS 10 Click the eBeam System Settings icon from the Mac OS 10 
docklet, then choose “Calibrate Projection Area” from the File 
menu. 

 

8. You are now ready to use Projection mode.  For more detailed explanations, 
instructions, and tips on Projection mode, see eBeam Software’s help system, 
accessible through the Help menu.  

Shortcut Strip - Calibrate & Use 

Quartet Portable IdeaShare comes with two Shortcut Strips: one static adhesive 
Shortcut Strip for whiteboard mode, and one Shortcut Strip embedded on the 
flipchart clip for Flipchart mode. 

The Shortcut Strip is only used in Whiteboard mode or Flipchart mode, and is not 
detected or used in Projection mode. 



Page 20 Using eBeam Software with Quartet Portable IdeaShare 

 

The Whiteboard Mode Shortcut Strip 

The static adhesive Shortcut Strip included with Quartet Portable IdeaShare allows 
you to issue Print Page and New Page commands while in whiteboard mode without 
going to your computer or leaving the whiteboard.  

With the Shortcut Strip mounted on your whiteboard within the Image Area, you can 
print a page or start a new page with a tap of the electronic pen to the Shortcut Strip 
on the whiteboard. 

eBeam Software does not detect the Shortcut Strip used for Whiteboard mode auto-
matically because you can apply it anywhere on the whiteboard. Before you can use 
the Shortcut Strip you must apply the strip to the board and enable it. 

Calibrate the Shortcut Strip 

1. After setting up the hardware and software, install the Shortcut Strip by removing 
the Shortcut Strip off its backing and applying the strip along an edge of the 
Image Area. 

The Shortcut Strip is best positioned along the bottom or side edge to avoid 
taking up writing space in the Image Area. 

2. Launch eBeam Software in whiteboard mode and select the Calibrate Shortcut 
Strip option as described in the table below. 

 

Platform Instructions 

PC Select “Shortcut Strip>Calibrate” from the Tools menu. 

Macintosh OS 9.X Select “Shortcut Strip>Calibrate” from the Tools menu. 

Macintosh OS 10 Select “Calibrate Shortcut Strip” from the System menu.   

3. Follow the calibration instructions on the screen.  When finished, the software 
shows the location of the Shortcut Strip within the Active Page as an outline of the 
Shortcut Strip.  

Note:  It is possible to write over the Shortcut Strip on the whiteboard.  
However, the software does not record writing anywhere within the Shortcut Strip 
area. 

Use the Shortcut Strip 

•  New Page. The top box on the Shortcut Strip is the “New Page” shortcut.  This 
creates a new empty page within eBeam Software’s whiteboard meeting.  Tap 
the shortcut with an electronic pen to issue a new page command. 

Information written on the whiteboard needs to be erased after the New Page icon 
has been tapped.  We recommend using a standard whiteboard eraser (Quartet 
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Prestige eraser, model PE1) for erasing the entire whiteboard after tapping New 
Page. 

•  Print Page. The bottom box on the Shortcut Strip is the “Print Page” shortcut, 
which prints the  current Active Page.  Tap the shortcut with an electronic pen 
to issue a print page command to the printer connected to your computer. 

Note:  See eBeam’s Help system for more information on the Shortcut Strip.  
Accessing Help is described in “The eBeam Software Help System” on page 22. 

The Flipchart Mode Shortcut Strip 

The Shortcut Strip attached to the flipchart clip allows you to issue Next Page, 
Previous Page, and Print Current Page commands while in Flipchart mode without 
going to your computer or leaving the flipchart. 

Because the Shortcut Strip is embedded on the flipchart clip, eBeam Software auto-
matically knows the location of the Shortcut Strip, making it unnecessary to calibrate 
the Shortcut Strip itself. 

Use the Shortcut Strip 

When using the flipchart clip, it is wise to place your computer where you can see 
which page is displayed in the eBeam Software flipchart meeting. In Flipchart mode, 
the page displayed in eBeam Software is the Active Page. It is important that the 
page displayed in eBeam Software is the same page that you are modifying on the 
flipchart. 

•  Next Page. The top box on the Shortcut Strip is the “Next Page” shortcut.   

If the most recent flipchart meeting page is displayed in eBeam Software, the 
Next Page shortcut creates a new empty page in eBeam Software’s Flipchart 
mode.  Tap the shortcut with an electronic pen to issue a Next Page command. 

If a previous flipchart meeting page is displayed in eBeam Software, the Next 
Page command causes the next page in the meeting to be displayed. 

•  Previous Page. The middle box on the Shortcut Strip is the “Previous Page” short-
cut.   

If the first page in the flipchart meeting in not displayed in eBeam Software, the 
Previous Page shortcut causes the previous page in the flipchart meeting to be 
displayed.  Tap the shortcut with an electronic pen to issue a Previous Page com-
mand. 

If the first page in the flipchart meeting is displayed in eBeam Software, the 
Previous Page command is ignored. 

•  Print Current Page. The bottom box on the Shortcut Strip is the “Print Current 
Page” shortcut, which prints the currently displayed page in eBeam Software.  
Tap the shortcut with an electronic pen to issue a print current page command to 
the printer connected to your computer. 
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Note:  See eBeam’s Help system for more information on the Shortcut Strip.  
Accessing Help is described in “The eBeam Software Help System” on page 22. 

The eBeam Software Help System 

eBeam Software’s Help system contains information on each software feature.  To 
access help in the Whiteboard mode application, choose “Contents” from the Help 
menu. 
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Chapter 4 

Troubleshooting 

Commonly encountered issues can be resolved by following the instructions below. 

See “Website Support” on page 25, and “Additional Technical Support” on page 25, 
for more information on Quartet IdeaShare support. 

Troubleshooting Tips 

 

Quartet Portable IdeaShare is set up as described in the Quick Set Up Guide, 
but eBeam Software is unable to detect the hardware. 

PC 
•  Check that the USB cable is attached to the receiver and to your computer. Select 

Retry. 

•  Check the LED around the logo plate on the IdeaShare receiver. If the LED is not 

glowing green, this indicates that the hardware is not getting any power. Try 

disconnecting and reconnecting the USB cable, and then select Retry. 

•  If the LED is still not lit, did the Add New Hardware wizard open? If it did, follow 

the instructions in the dialog. If Windows is unable to automatically find the 

requested driver (hidden.drv), and you do not have the Windows installation CD, 

browse to c:\Windows\system or c:\Windows\system32. Do not cancel before the 

driver installation is complete, or the hardware will lose power. 

•  Select “eBeam Hardware>Detect” from the Tools Menu. This attempts to connect 

to the hardware according to the settings in the “Tools>eBeam Hardware Setup” 

dialog. 

•  Make sure no other software has the specified port open. For example, PDA 

synchronization applications typically retain control of the port even when not 

synching. Close any application that may be running. 

•  Do you have more than one copy of the software installed on your computer? If 

so, the other copy may be running and have control of the port. Shut down the 

other copy. We recommend that old versions of the software be uninstalled from 

your computer. 

•  Exit the application and restart it. 

•  Check that the electronic eraser is not resting on the eraser pad. This might be 

causing the eraser to send a signal to the hardware continuously. 
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Message “The eBeam hardware is currently in projection mode. Would you 

like to use the eBeam hardware for this application?” This message might 

appear at Whiteboard mode application startup, after selecting “Capture 

from Whiteboard”, or after selecting “Capture from FlipChart”.  

Macintosh 
•  Message displayed if you are trying to open or switch to the digital whiteboard 

application while the software is in projection mode. See “Software Installation & 

First Time Use”  on page  12 for a description of how to change modes. 

  

eBeam Software indicates that the hardware is detected, but writing does 

not appear in Whiteboard mode application’s Active page. 

PC / 
Macintosh •  Press the electronic pen down on the whiteboard. If you do not hear a faint 

buzzing, replace the batteries. 

•  Try another electronic pen. If the other electronic pen works, replace the batteries 

in the electronic pen that does not work. 

•  Make sure you are not holding the electronic pen too close to the tip of the 

electronic pen. This blocks the signal. 
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Website Support 

For additional help, consult the Frequently Asked Questions section of the Quartet 

IdeaShare webpage at www.GBCOffice.com. 

Additional Technical Support 

If you have difficulties installing or using your Quartet Portable IdeaShare, please 

re-check the section of the User Guide or Quick Set Up Guide that relates to your 

problem. If you are still unable to solve the problem, please contact our Customer 

Service Team for assistance. 

Customer Service 

(800) 541-0094 USA 

(800) 605-6513 Canada 

contactus@gbc.com 

Please have the following information ready when you contact customer service: 

•  Model number: Quartet Portable IdeaShare Q8000. 

•  Date and proof of purchase. 

•  Operating system of your computer (Windows 98, XP, Macintosh OS 10, etc). 

•  Software you use with this product (eBeam Software version, PDA software, etc). 



 

 

Warranty 

Limited Hardware Warranty 

Quartet warrants to the original purchaser for a period of 1 year after purchase that 
this Quartet product's hardware is free from defects in workmanship and material 
under normal use and service. Quartet's obligation under this warranty is limited to 
replacement or repair, at Quartet's option, of any warranted part found defective by 
GBC without charge for material or labor. 

THIS WARRANTY IS IN LIEU OF ALL OTHER EXPRESS WARRANTIES.  REPRESENTA-
TIONS OR PROMISES INCONSISTENT WITH, OR IN ADDITION TO, THIS WARRANTY 
ARE UNAUTHORIZED AND SHALL NOT BE BINDING UPON QUARTET.  IN NO EVENT 
SHALL GBC BE LIABLE FOR ANY SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAM-
AGES, WHETHER OR NOT FORESEEABLE.  SOME STATES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU. 

ANY IMPLIED WARRANTIES ARE LIMITED IN DURATION TO THE DURATION OF THIS 
WARRANTY.  SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN 
IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

This warranty shall be void if the product has been misused, damaged by negligence 
or accident, or altered by anyone other than Quartet or Quartet's authorized agents. 

This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state. 

European Union Residents Only:  this warranty does not affect the legal rights which 
consumers have under applicable national legislation governing the sale of consumer 
goods. 

 

 

 

 

 

 

 

 

 



 

 

Copyright Notice 

 

Copyright © 2008 Luidia, Inc. All rights reserved. 

This equipment is for use with general purpose, UL-Listed personal computers. 

This publication is protected by copyright, and all rights are reserved. No part of it 
may be reproduced or transmitted in any form or by any means for any purpose 
without express prior written consent from Luidia, Inc., except as expressly permitted 
herein.  

Information in this document is subject to change without notice and does not repre-
sent a commitment on the part of Luidia, Inc. 

The software described in this publication is furnished under license and may only be 
used or copied in accordance with the terms of such license.  

Protected by U.S. Patent 5,866,856. Patents pending. 

Trademarks  

Quartet and IdeaShare are trademarks of General Binding Corporation. 

eBeam, e-Beam, eBeam Software, eBeam Mouse, eBeam Moderator, and ImagePort 
are trademarks of Luidia, Inc. 

Acrobat, Adobe, and Adobe Acrobat are registered trademarks or trademarks of 
Adobe Systems, Inc. in the United States and/or other countries. Microsoft, MS, 
NetMeeting, Windows, and Windows NT are registered trademarks or trademarks of 
Microsoft Corporation in the United States and/or other countries. Netscape Navigator 
is a registered trademark or trademark of Netscape Communications Corporation in 
the United States and/or other countries. Pentium is a registered trademark or 
trademark of the Intel Corporation in the United States and/or other countries. 
Sanford and EXPO are registered trademarks or trademarks of Sanford Corporation in 
the United States and/ or other countries. All other terms and product names may be 
trademarks or registered trademarks of their respective owners, and are hereby 
acknowledged. 

LUIDIA, INCORPORATED END-USER LICENSE AGREEMENT. YOU SHOULD CAREFULLY 
READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE.  



 

 

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO 
NOT USE THE SOFTWARE.  INTALLING OR USING THE SOFTWARE INDICATES THAT 
YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. 

LICENSE:  Luidia, Inc. grants you a non-exclusive license to use the software ("Soft-
ware") and accompanying documentation ("Documentation") on any computer, pro-
vided that the Software is used only in connection with the eBeam™ product 
("Product") you have obtained, subject to the terms and restrictions set forth in this 
Agreement.  The Software is licensed, not sold. 

You may use the Software solely for your own customary business or personal pur-
poses and solely in connection with the Product.  You may permanently transfer all of 
your rights under this Agreement only as part of a sale or transfer of the Product, 
provided you retain no copies, you transfer all of the Software and Documentation 
(including all component parts, the media and printed materials, any upgrades, and 
this Agreement), AND the recipient agrees to the terms of this Agreement.  If the 
Software is an upgrade, any transfer must include all prior versions of the Software. 

You may not make or have made, or permit to be made, any copies of the Software 
or portions thereof, except as necessary for backup or archive purposes in support of 
your use of the Software as permitted hereunder.  You may not copy the 
Documentation.  You may not attempt to alter, disassemble, decrypt or reverse 
engineer the Software.  You may not lease or rent the Software. 

PROPRIETARY RIGHTS:  You acknowledge that the Software and Trademarks are 
proprietary to Luidia, Inc.  and its suppliers and that title and other intellectual 
property rights therein remain with Luidia, Inc. and its suppliers.  Except as stated 
above, this Agreement does not grant you any right to patents, copyrights, trade 
secrets, trademarks (whether registered or unregistered), or any other rights, 
franchises or licenses in respect of the Software or Trademarks.  You may not adapt 
or use any trademark or trade name which is likely to be similar to or confusing with 
that of Luidia, Inc. or any of its suppliers or take any other action which impairs or 
reduces the trademark rights of Luidia, Inc. or its suppliers. 

CONFIDENTIALITY:  You agree to hold the Software in confidence, disclosing the 
Software only to authorized users having a need to use the Software as permitted by 
this Agreement and to take all reasonable precautions to prevent disclosure to other 
parties. 

REMEDIES AND TERMINATION:  Unauthorized use, copying or disclosure of the Soft-
ware, Trademarks or any breach of this Agreement will result in automatic 
termination of this license and will make available to Luidia, Inc. other legal remedies.  
In the event of termination, you must destroy all copies of the Software and all of its 
component parts.  All provisions of this Agreement relating to disclaimers of 
warranties, limitation of liability, remedies, or damages, and Luidia's proprietary 
rights shall survive termination. 

LIMITED WARRANTY AND DISCLAIMER:  Luidia, Inc. warrants to the original 
purchaser ("Customer") for one (1) year from the date of original purchase from 



 

 

Luidia, Inc. or its authorized retailer that the Software will perform in substantial 
conformance to the Documentation.  Luidia, Inc. warrants the media containing the 
Software against failure during the above warranty period.  Luidia, Inc. makes no 
warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted or error free, or that all 
defects in the Software will be corrected. 

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, LUIDIA MAKES AND YOU 
RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, 
STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICA-
TION WITH YOU, AND LUIDIA SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR 
CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

LIMITATION OF LIABILITY:  IN NO EVENT WILL LUIDIA OR ITS SUPPLIERS BE 
LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST PROFITS, COST OF 
COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR 
FAILURE OF THE SOFTWARE, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY.  
THIS LIMITATION WILL APPLY EVEN IF LUIDIA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.  YOU ACKNOWLEDGE THAT THE PRICE OF THE 
PRODUCT REFLECTS THIS ALLOCATION OF RISK.  BECAUSE SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL 
OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

EXPORT CONTROLS:  You agree that you will not export or re-export the Software in 
any form in violation of any applicable laws or regulations of the United States or the 
country in which you obtained them. 

GOVERNMENT USE:  Use, duplication or disclosure of the Software by the United 
States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of 
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 
or in subparagraphs (c) (1) and (2) of the Commercial Computer Software-Restricted 
Right Clause at 48 CFR 52.227-19, as applicable. 

GENERAL: the laws of the State of California govern this Agreement.  You agree that 
this Agreement shall not be subject to the United Nations Convention on Contracts for 
the International Sale of Goods (1980). This Agreement is the entire agreement held 
between us and supersedes any other communications or advertising with respect to 
the Software.  If any provision of this Agreement is held invalid, the remainder of 
this Agreement shall continue in full force and effect. 

 

 

 

 

 



 

 

 

 


